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 Introduction 
The DNP3 protocol is used to exchange data reliably between partners on a link or over a 
communication network. The following topics are addressed in this document: 

1- Introduction to the DNP3 protocol, which describes static data, events, event stacks, 
classes of events, variations, groups, objects, reading the data, protocol functions, 
unsolicited responses and levels of implementation. 

2- Integrating the DNP3 protocol in the RightWON, which describes the interrelationships 
between the IEC 61131-3 PLC application, fieldbus manager, DNP3 stack, network 
management link and the equipment. It describes the licenses that are available for 
using the protocol. It presents an example that will be used in this manual to show how 
the DNP3 protocol is configured. 

3- Tutorial on DNP3 Slave configuration, which describes installation of license key, insertion 
and basic configuration of the DNP3 Slave, the DNP3 port, a Session and variables, with 
an example of configuring the DNP3 protocol in static or event mode. 

4- Tutorial on DNP3 Master configuration, which describes installation of the license key, 
insertion and basic configuration of the DNP3 Master, the DNP3 port, a Session and 
variables, with an example of configuring the DNP3 protocol in static or event mode. 

5- Example of the data exchange between Master and Slave, which describes operations 
between a Master and a Slave using the DNP3 example. 

6- Configuring a project in Master/Slave mode, which describes the configuration of a DNP3 
Master/Slave application. 

1.1. Introduction to the DNP3 protocol 
The DNP3 protocol is used to exchange data reliably between a Master and one or more Slaves. 
The DNP3 protocol provides functions for exchanging data using a standardized format. The 
protocol allows the exchange of static data and events. 

1.1.1. Static data 
Static data refers to snapshots of data values. For example, a static binary input refers to the 
current state (e.g. On or Off) of a device. A static analog input refers to the value of a 
measurement at the moment it is exchanged between the Slave and the Master (e.g. the value 
of the current or voltage on a pole). The DNP3 protocol permits retrieval of some or all of the 
static data from a Slave station. 

1.1.2. Events 
Events are associated with something significant that is happening at the outstation. Examples 
are state changes on binary inputs, analog values that exceed certain thresholds, the most 
recent information available, etc. An event occurs when a binary input changes value (e.g. On to 
Off) or when an analog value undergoes a change that is greater than its allocated deadband. 

1.1.3. Event stacks 
Since several successive events can occur on the same point during communication exchanges 
between partners, the events are stored in FIFO (First-In First-Out) stacks. DNP3 offers event 
stack reporting with or without timestamps, so the Master can have the chronology of events. 
The Master can request DNP3 event reporting on demand. Usually, a Master will update more 
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rapidly if it requests events from the outstation most of the time, with the occasional request for 
retrieval of static data to ensure integrity. 

1.1.4. Event classes 
DNP3 divides events into three classes: Class 1 events are considered the highest priority, 
followed by events in classes 2 and 3, the latter being the lowest priority. The Master can send 
requests to retrieve specific class 1, 2 or 3 events or any combination of these. 

1.1.5. Variations 
DNP3 has provisions for representing data in different formats, called variations. Thus static 
analog data (present values) can be represented as follows: 

1. A 32-bit integer value with the status 
2. A 16-bit integer value with the status 
3. A 32-bit integer value 
4. A 16-bit integer value 
5. A 32-bit real value with the status 
6. A 64-bit real value with the status 

The status is a single-byte field that indicates whether the measurement source is online, 
whether the data source has been renewed, whether communications with a downstream source 
have been lost, whether the data has been forced and whether the value is above threshold. 

Not all DNP3 devices support the 6 data variations, but all devices must be able to transmit the 
simplest variation so that any receiver can interpret the message. 

Analog event data can be represented by the following variations: 

1. A 32-bit integer value with the status 
2. A 16-bit integer value with the status 
3. A 32-bit integer value with the status and timestamp 
4. A 16-bit integer value with the status and timestamp 
5. A 32-bit real value with the status 
6. A 64-bit real value with the status 
7. A 32-bit real value with the status and timestamp 
8. A 64-bit real value with the status and timestamp 

1.1.6. Groups 
Groups permit the differentiation of static data from events, for example, to distinguish 
variations 1 and 2 of analog events from variations 1 and 2 of static analog values. 

For example, static analog values may be assigned to group 30 while analog events are 
assigned to group 32. Group 30 can be formatted in one of the 6 variations, and group 32 can 
be formatted in one of the 8 variations associated with analog events. 

When a Slave transmits a response message that contains data, the message identifies the 
group number and variation for each data value in the message. Group and variation numbers 
are also assigned to counters, binary inputs, controls and analog outputs. In fact, all types of 
valid data and DNP3 formats are identified by group numbers and their variation. 

 



Document No. RWM002010-MA-en RightWON DNP3 Protocol Manual V2.3.1 
 

 

© 2013 Vizimax, Inc.  3 
All rights reserved. www.vizimax.com 

1.1.7. Objects 
The objects in a message are the coded representation of data obtained from a point or other 
structure. The format of the object depends on the group and selected variation number. Thus 
when transmitting data, the sender must properly encode the information so that the receiver 
can correctly analyze and interpret the data. The bits and bytes associated with the dataset in 
the message are called objects. 

1.1.8. Reading the data 
The DNP3 Master formulates requests that indicate to a Slave station what function it must 
perform, such as reading, while specifying the type of data to be obtained. The request may 
specify the desired number of objects, specific objects or a series of objects from index number 
X to Y. 

In the RightWON, requests from the Master are function blocks that interact with the DNP3 
stack. Upon receipt of a request, the Slave station validates it to prevent errors, then assembles 
the response message from Variables identified in the profile. 

1.1.9. DNP3 protocol functions 
Reading the data was dealt with briefly in the previous section, but DNP3 software is designed 
to manage other functions, as well. Among other things, the Master can perform the following 
functions: 

• Synchronize the clock on the Slave station(s), 
• Request to freeze running counters to prevent data loss between two successive requests 

for a read of the counters, 
• Send control operations over digital output points or settings over analog outputs using 

the “Select-Before-Operate” or “Direct-Operate” operating sequences, 
• Request a read of a class, 
• Request a read of a group in a specific session, 
• Request a read of one or more data items in a specific session, 
• Send a binary command in a specific session, 
• Send a binary command, 
• Send an analog command, 
• Write a character string in a specific session. 

1.1.10. Unsolicited responses 
Unsolicited responses are the transmission of unsolicited messages. This is an operating mode 
where the Slave station spontaneously transmits data without prior receipt of a specific request 
from the Master. Not all DNP3 Slave stations have this capability. This mode is useful when the 
Master communicates with several Slaves and requires notification as soon as possible after an 
event has been triggered. Rather than waiting for a polling cycle from the Master, the Slave 
station sends an unsolicited message. Before configuring a system for unsolicited messages, 
system interoperability and communication link specifications must be considered. 

1.1.11. Levels of implementation 
The DNP3 organization (www.dnp.org) acknowledges that the support of all features offered by 
the protocol is not necessary for all applications. The DNP3 organization has defined three levels 
of application complexity: 

• Level 1 simply provides the basic functions; all others are optional. 
• Level 2 offers more features concerning groups and variations. 
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• Level 3 is the most sophisticated. 
Each level limits the request/response combinations in order to simplify implementation and 
ensure system interoperability. 

1.2. Document scope 
This document describes the integration of the DNP3 communication protocol in the RightWON 
system using the RightWON Configuration Suite software. 

1.2.1. Other documents 
For further details on the information in this document, refer to the specific manuals below: 

Reference No. Document Name 
RWM000010-MA RightWON Configuration Suite Manual 
RWM000020-MA RightWON – User Guide 
RWM000050-MA RightWON Satellite – User Guide 
RWM000060-MA RightWON Engine IEC61850-3 – User Guide 
RWM000061-MA RightWON Engine Rackmount – User Guide 
RWM000062-MA RightWON Engine Standalone – User Guide 
RWM000080-MA RightWON Configuration Suite – Application Guide 

1.3. Document conventions 
To facilitate the reading of this document the following conventions are used: 

• Menu/dialog controls and items are in bold, e.g. Options/Advanced settings…, as are 
buttons, e.g. OK 

• Names of Categories, Users, Sectors and Tags defined by the system integrators are in 
italics, e.g. John Smith, Generator 

• Application-specific items such as Sector, Tag, Category and User group begin with a 
capital letter 

• Hyperlinks are in blue 

• The  symbol is used to raise the reader's attention. 
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1.4. Safety precautions 
To ensure the safety of personnel and products, and to prevent the risk of accident, you must 
strictly follow the cautions and warnings written on product labels, in the manuals and on the 
RightWON product packaging. 

To ensure proper operations of the RightWON product, read this manual in its entirety before 
proceeding to the other stages of learning, hardware installation, configuration or operation. 
Make sure that you fully understand the product and all information provided in this manual. For 
further information, contact your representative (certain fees and conditions may apply, 
depending on the type of service requested). 

1.4.1. Warnings  
RightWON products are not designed for safety management applications or as security devices. 
Mishandling of this product could cause critical situations leading to personal, equipment or 
property damage, network failure, loss of data, electrical shock, serious injury or even death. To 
prevent such events from occurring: 

• Take all possible measures to ensure the security of your systems through the use of 
appropriate equipment that meets the requirements of the application. This will help 
preserve the integrity of your systems in the event of product failure or other external 
factors. 

• To prevent the risk of explosion, do not use RightWON products in areas where 
explosives are stored without taking appropriate measures as defined by the standards 
and regulations in effect, obtained from the proper local authorities. 

• To prevent damage to electronic components, do not expose this product to open flame 
or submit it to environmental factors that exceed the recommended levels. 

• Batteries may explode if they are not handled with care. Do not recharge, disassemble 
or dispose of in fire. We recommend that you recycle these items by taking them to the 
appropriate collection service. 

1.4.2. Cautions  
• Make sure that RightWON products are managed by qualified personnel who have been 

properly trained to install, configure and troubleshoot them. 
• Always configure and operate this product within the technical specifications and 

operating criteria recommended by Vizimax, as cited in this manual and the other 
technical documents available. 

• Use homologated external emergency devices, including but not limited to: emergency 
stop, emergency signaling, interlock and safety circuitry. 

• Properly connect and secure removable cables and connectors. Loose connections could 
overheat and catch fire. 

• Protect all power supplies and connect to ground on the equipment using an appropriate 
connection. Failure to protect and/or ground the equipment could lead to fatal electrical 
shock. 

• Take all possible measures to prevent foreign materials from falling into the product 
interior (liquids, flammable materials, metal objects, etc.). 

• Turn the equipment off and disconnect all sources of power before undertaking any 
procedure whatsoever on the equipment. 

 



Document No. RWM002010-MA-en RightWON DNP3 Protocol Manual V2.3.1 
 

 

© 2013 Vizimax, Inc.  6 
All rights reserved. www.vizimax.com 

 Integrating the DNP3 protocol in the RightWON 
2.1. DNP3 management 
DNP3 protocol support is an optional component of the RightWON which requires a license key 
for the Master, the Slave, or a combination of the two. The RightWON supports all three 
operating modes of the DNP3 communication protocol: 

1. Master mode: Allows the RightWON to exchange data with one or more intelligent 
devices operating in Slave mode. This may be a measurement device, another 
RightWON, etc. Master mode is typically used for carrying out communication gateway 
functions, such as those between an IEC 61850 client and a DNP3 Slave. 

2. Slave mode: Allows the RightWON to manage the information and exchange it with the 
Master. This information can come from local inputs/outputs integrated with the 
RightWON, remote inputs/outputs on the CANbus, or intelligent electronic devices (IEDs 
or PLCs) connected to the RightWON. Slave mode is typically used to meet the needs of 
intelligent RTUs. 

3. Master/Slave mode: Allows the RightWON to run in mode 1 and, in addition, act as a 
bridge to the outside so as to exchange the data gathered from RightWON Slave stations 
with another external link that uses the DNP3 protocol. 

In the following figure the three operating modes: Master, Slave and combined Master/Slave, 
are illustrated in typical applications. 

Error! Objects cannot be created from editing field codes. 

 

All data carried by the DNP3 protocol are translated into variables in the IEC 61131-3 PLC 
application. Thus, the protocols are managed using the fieldbus manager Error! Objects 
cannot be created from editing field codes. under the supervision of PLC automation 
programs. The fieldbus manager exchanges the variables between the DNP3 stack and the PLC 
application. The correspondence between variables and addresses/protocol functions is 
established in the fieldbus manager environment. 
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In the application the Master protocol is managed using function blocks that are specific to the 
DNP3 protocol. For example, a specific function allows the Master to send a control command to 
a point on a Slave outstation. The PLC application that manages the Master thus has an active 
role in protocol management and initiates the transactions. However, only one assignment of 
variables to addresses/protocol functions is required, using a communication profile . 

The RightWON supports the DNP3 Master and Slave protocol on several types of communication 
links: 

1. Ethernet link using TCP/IP. 
2. PPP connection, which permits establishing a network connection over a serial connection 

(modem or cellular telephone). 
3. Direct RS-232 or RS-485 serial connection. 

The Links manager in the Network Configurator Error! Objects cannot be created from 
editing field codes. allows you to select the type of communication link provided by the 
RightWON hardware configuration. 

2.2. DNP3 protocol in static or event mode 
Here are two basic methods for using the DNP3 protocol on a Master and Slave that 
communicate together: 

Slave and Master in static mode: In this case all static points (variables) on the Slave station 
are retrieved periodically when the Master station sends an integrity data poll. 

If event Variables are declared in a Slave station configured in static mode, the Slave transmits 
the events. 

Slave and Master in event mode: As soon as the Master and Slave are connected, the Slave 
sends the events to the Master station. When new events occur in the Slave station, they are 
sent to the Master station according to the configuration and the event class priority. 



Document No. RWM002010-MA-en RightWON DNP3 Protocol Manual V2.3.1 
 

 

© 2013 Vizimax, Inc.  8 
All rights reserved. www.vizimax.com 

If static Variables are also declared, the Master must be configured to execute an integrity data 
poll to periodically retrieve all static Variables. 

2.3. License key for the DNP3 protocol 
DNP3 protocol support on the RightWON platform requires prior installation of a license key 
(dongle) that is chosen according to the platform model and the protocol operating mode. A 
license key is required for each RightWON unit. The RWU-Protocol dongle is intended for the 
modular RightWON CPU (RWU 010000) and the RWE-Protocol dongle is for the RightWON 
Engine series (RWE 04xxxx). 

Product Description Product No. Comments 
RWU/PROT/DNP3/SLAVE RWC 00AR00  
RWU/PROT/DNP3/MASTER RWC 00AS00  
RWU/PROT/DNP3/MASTER+SLAVE RWC 00AT00  
RWE/PROT/DNP3/SLAVE RWC 00AR01 Supports up to ten (10) concurrent Slave 

sessions. 
RWE/PROT/DNP3/MASTER RWC 00AS01  
RWE/PROT/DNP3/MASTER+SLAVE RWC 00AT01  
RWU/SAT/PROT/ALL RWC 00BS00 This license permits the use of all available 

communication protocols for a limited period 
of two weeks for one RightWON unit. 
This protocol is available for system 
integrators and the sales network. 

RWE/PROT/ALL RWC 00BS01 

 

You can obtain the license key from your Vizimax representative. You must register the license 
key on the platform before you can use it. 

2.4. DNP3 tutorial example presentation 
The tutorial example on DNP3 configuration includes one Slave and one Master that 
communicate with each other via the DNP3 protocol over a serial communication port. In this 
example, the Slave simulates an anemometer. Variables include the wind speed (rWindSpd), 
wind direction (diWindDir), and the opening/closing of a circuit breaker (bOpenBreaker) and 
pressure valve (bOpenCloseValve). The anemometer measures the wind speed (rWindSpd) and 
direction (diWindDir). The Slave sends events to the Master, or the Master performs an integrity 
poll to retrieve data from the Slave. When the Slave requests the opening or closing of the 
circuit breaker, the Master sends a binary command to change the status of the circuit breaker 
(bBreakerSts). When the Slave requests the opening or closing of the pressure valve, the 
Master sends an analog command to change the pressure of the valve in the Slave 
(rPressureValve). 
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 Tutorial on DNP3 Slave configuration 
Configuration of a DNP3 Slave in the RightWON requires the following steps: 

1. Installing the license key for the DNP3 protocol 
2. Adding the DNP3 Slave protocol to the RightWON configuration 
3. Configuration parameters for the DNP3 Slave 
4. Inserting a communication port 
5. 
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Configuring the communication port 
6. Inserting a data block (Session) on the DNP3 port 
7. Configuration parameters for a Slave Session 
8. Adding a Variable 
9. Configuring a Variable 
10. Configuring DNP3 commands from the Master station 
11. Configuring error report variables 
12. Example of DNP3 Slave static configuration 
13. Example of DNP3 Slave event configuration 

3.1. Installing the license key for the DNP3 protocol 
To activate the license key for the DNP3 protocol, follow the steps provided in the section 
Activate your RightWON advanced features license of the document RWM000010-MA-en, 
RightWON Configuration Manual. 

3.2. Adding the DNP3 Slave protocol to the RightWON configuration 
The DNP3 Slave can be added to the RightWON configuration when a new project is created, or 
through the fieldbus manager by carrying out the following operations: 

1- Start the fieldbus configurator by clicking Fieldbus Configurations  in the toolbar. 

2- Click Insert Configuration…  in the editing area toolbar. 
3- Expand the DNP3 configuration in the new Add Configuration window and double-click 

on the DNP3 Slave protocol. 

 
4- Next, you must configure the DNP3 Slave protocol. 
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3.3. Configuration parameters for the DNP3 Slave 
After adding the DNP3 protocol, you can configure it using Fieldbus Configurations . The 
DNP3 protocol can be configured in static or event mode. To view the parameters to configure, 
click on the DNP3 Slave in the IO Drivers window. 

Double-click a parameter to configure it. Enter the data in the field and press Enter on the 
keyboard. To enable (checked box) or disable the parameter, click on the box. 

 
 

 

Here is the list of available parameters on the right side of the IO Drivers window: 

1. Log traces: The log messages are displayed in the runtime tab of the output window of 
the RightWON Configuration Suite. This should be reserved for troubleshooting. 

2. Default Class Event: Defines the property of a class of points that will be used if the 
default is selected for the Variable, with the following options: 

• NONE: Class 0 defines the static points. 
• ONE: Class 1 defines points in high-priority events. 
• TWO: Class 2 defines points in medium-priority events. 
• THREE: Class 3 defines points in low-priority events. 

3. Default variation: Defines the variation that will be used if the default option is selected 
for a point that has the static variation or event variation property. The objects for a 
point's static variation or event variation properties are divided into two (2) groups: 

a. Static Objects: 1, 3, 10, 20, 21, 30 and 40. 
b. Event Objects: 2, 4, 22 and 32. 
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4. Event mode: Defines the event mode that will be used for unsolicited messages. There 

are two options: 
a. ALL: Sends all events in chronological order. 
b. MOST RECENT: Sends only the most recent event for each point. 

5. Max Event Count: Defines the maximum number of events in unsolicited messages for 
each group. 

6. Device attributes: Allows the Master station to read specific information from the Slave, 
using the following user-configured parameters: 

a. User-assigned location name: Name of the location assigned by the user. 
b. User-assigned ID: Identification of the slave station assigned by the user. 
c. User-assigned device name: Name of the device assigned by the user. 

7. Misc: Permits defining various global parameters on the Slave station, such as: 
a. Clock valid period: Specifies the delay after receiving a clock synchronization 

before the DNP3 protocol will request another clock synchronization. 
b. Output select timeout: Corresponds to the maximum time allowed between 

selection and execution during an SBO command. 
c. Integrity poll response groups: Permits defining the groups of static objects 

that will respond to a data poll request from the Master. 
 

8. Use VSI for flags and TimeStamp: Permits using status flags and timestamps 
according to the following options: 

o Don’t use VSI: Do not use standard variable status bits (VSI) 
o Use VSI: Use standard VSI 
o Use Std VSI and User bits (1-8): Use standard VSI and user bits (1-8) 

The following is the list of DNP3 user bits and their associated variable bits. For 
definitions of the variable bits, see List of status bits in the RightWON Configuration 
Suite Help by pressing the F1 key. 

DNP3 user bits Variable bits: ID 
Bit 0: Online Bit 18 reversed: _VSB_I_BIT 
Bit 1: Restart Bit 16:_VSB_GR 
Bit 2: Communication lost Bit 46: _VSB_NT_BIT 
Bit 3: Forced to remote Bit 45: _VSB_SP_BIT 
Bit 4: Forced to local Bit 2: _VSB_ST_M2 
Bit 5: Over range Bit 47: _VSB_OV_BIT 
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Bit 5: Chatter filter Bit 3: _VSB_ST_M2 
Bit 5: Counter overflow (not linked) 
Bit 6: Reference check Bit 1: _VSB_ST_M2 

3.3.1. Activate status bits 
To activate status bits management: 

1. Select Project>Settings. 

2. In Compiler section, double-click on Allocate status flags for variables with 
embedded properties. 

3. Click OK. 

3.4. Inserting a communication port 
A Slave can have only one port for communicating with a Master. A Master can have up to two 
communication ports. Inserting a port (Channel) for DNP3 is carried out as follows: 

1- In the Fieldbus Configurations , click on DNP3 in the IO Drivers window. 
2- Under the Insert menu, click Insert Master/Port…  

 
3- You must now configure the port in either serial or Ethernet mode. 
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3.5. Configuring the communication port 
After adding a port to the DNP3 protocol, it must be configured in either serial mode or Ethernet 
mode (TCP/IP). The Slave and Master must be configured with the same communication mode 
to be able to communicate together. If several Slaves are configured with a port in serial mode 
and several others in Ethernet mode, the Master can have one serial port and one Ethernet port. 

3.5.1. Configuring the DNP3 port in Serial mode 
After inserting the port, you can configure it in serial mode using the Fieldbus 
Configurations , by carrying out the following steps: 

1- Click on the Channel in the IO Drivers window. 

2- Double-click the Channel Name field. Enter a meaningful and unique port name, then 
press the Enter key. 

3- Double-click the Mode field. Select the Serial communication mode, which is valid for 
RS-485/RS-232 communication. 

Note: The communication mode must be the same between a Master and a Slave. 

 
4- Double-click the Connection Settings field. Enter the name of the serial connection, 

using the name defined in the network configurator (see Note). Press the Enter key. 

Note: Open the Network Configuration  and select the Serial-x link under Links. 
In the Adapter to use area, expand the tree. Click on Serial-x under Front-1 or Front-
2, depending on where the serial communication module is installed. Concatenate the 
Serial-x name in the Links section with the Conn-x name in the Connections section 
(e.g. Serial-1.Conn-1 in the figure below). 
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5- Double-click the Link Confirm Time Out (ms) field. Enter the timeout (in milliseconds) 

for verifying the status of the communication link. Press Enter on the keyboard. 

6- The Diag Mask field contains the mask for diagnostics of the various communication 
layers (default 16#00000000: no diagnostics). To configure it, double-click the field. A 
Select Trace Options window opens. Click the following fields to activate them, if 
desired: 

o Show Time Stamps: Displays the timestamps 
o Show Errors: Displays the errors 
o Trace low-level layer: Traces the low-level layers of the OSI model 
o Trace Physical layer: Traces the physical layer of the OSI model 
o Trace Link layer: Traces the link layer of the OSI model 

Then click OK. 
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3.5.2. Configuring the DNP3 port in Ethernet (TCP/IP) mode 
After inserting a DNP3 port, you can configure the port in Ethernet (TCP/IP) mode using the 
Fieldbus Configurations , by carrying out the following steps: 

1- Click on the Channel in the IO Drivers window. 

2- Double-click the Channel Name field. Enter a meaningful and unique port name (e.g. 
Ethernet), then press the Enter key. 

3- Double-click the Mode field to select the communication mode between the Master 
station and the Slave stations. Choose Ethernet TCP-IP mode. 

Note: The communication mode must be the same between a Master and a Slave. 

 
4- Double-click the Connection Settings field.  

a. For the Slave, enter the DNP3 port number (default 20000).  

b. For the Master, enter the IP address of the Slave.  

Press the Enter key. 

5- Double-click the Link Confirm Time Out (ms) field. Enter the timeout (in milliseconds) 
for verifying the status of the communication link. Press the Enter key. 

6- The Diag Mask field contains the diagnostics mask for the various communication layers 
(default 16#00000000: no diagnostics). To configure it, double-click the field. A Select 
Trace Options window opens. Click on the following fields to activate them, if desired: 

o Show Time Stamps: Displays the timestamps 
o Show Errors: Displays the errors 
o Trace low-level layer: Traces the low-level layers of the OSI model 
o Trace Physical layer: Traces the physical layer of the OSI model 
o Trace Link layer: Traces the link layer of the OSI model 

Then click OK. 
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7- For Ethernet Connection mode, double-click to change between TCP or UDP. For 

GSM, It is recommended to use UDP. 

8- For Ethernet Connection timeout, double-click to enter the time, in ms, before a 
timeout is declared. If your connection link is slow such as a GSM link, enter a longer 
time to allow the channel to connect. 

9- To verify if the connection is active, configure TCP Keep alive: 

a. Enable TCP Keep alive by checking Keep connection alive. 

b. Enter the Delay in seconds between signals. 

c. Enter the number of consecutive Retry count attempts without response before 
closing the connection. 

3.6. Inserting a data block (Session) on the DNP3 port 
A Slave can have only one session for communicating with a Master. The Master can have one 
session for each Slave with which it exchanges data. 

To insert a Session on a port, carry out the following steps: 

1- From Fieldbus Configurations , click on the Channel in the IO Drivers window. 

Note: To communicate with each other, the Master and Slave must be configured with 
the same type of port. For the Master, click on the DNP3 Master Channel that 
corresponds to the same type of port configured in the DNP3 Slave. 

2- Click Insert Slave/Data Block…  under the Insert menu. 

3- A new Session window appears. In this window, click OK to create the new 
configuration. 

 
4- You must now configure the session as either a DNP3 Slave Session or a DNP3 Master 

Session. 
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3.7. Configuration parameters for a Slave Session 

After inserting a session, you can configure it using the Fieldbus Configurations . The 
DNP3 protocol can be configured in Static or Event mode. To view the configuration parameters, 
click Session in the I/O Drivers window. 

Double-click a parameter to configure it. Enter the data in the field and press the Enter key. To 
enable (checked box) or disable a parameter, click on the box. 

 
Here is the list of available parameters on the right side of the IO Drivers window: 

1- Session ID: Enter a unique identification number for the session. The first session must 
be 0 and the second, 1. Other session numbers must follow in numerical order. 

2- Session Name: Enter the name of the session. 
3- Outstation Address: Enter the address of the Slave station. 
4- Master Address: Enter the address of the Master station that will be used for sending 

unsolicited messages. If Validate Master Address is false (unchecked), the address 
specified in the received frame will be used for sending unsolicited messages. If Validate 
Master Address is true (checked), then: 

• If the Master Address matches the address in the received frame, the responses 
will be sent to the Master station address. 

• If the Master Address does not match the address in the received frame, no 
response will be sent. 

5- Validate Master Address: Permits validating the Master station address in received 
frames with the address specified by the Master Address. If false (unchecked), DNP3 
does not validate the Master address, and frames with a Slave station address matching 
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the Outstation Address will be accepted. If true (checked), the address of the Master 
and Slave stations must match for the frames to be accepted. 

6- Self address enable (code 0xfffc): The Slave responds to address 0xfffc as if it 
received a request for its configured address. The Slave responds with its own address, 
which allows the Master to automatically detect the address of the Slave. 

7- Keep Alive: Enter the time (in milliseconds) between signals that verify the status of the 
connection between the Master and Slave (Link Confirm Time Out on the Channel). 

8- Application confirm timeout: Specifies the time (in seconds) that the DNP3 Slave will 
wait after receiving an acknowledgment from the Master. 
Note: This parameter in combination with Unsolicited retry delay and Unsolicited 
offline retry delay determines how often an unsolicited response will be resent. 

9- File transfer timeout: Enter the time (in seconds) allocated for transferring a file before 
declaring a file transfer failure (timeout). 
Note: The time must be adjusted to the type of communication mode selected (Serial or 
Ethernet). 

10- Allow master to set the local clock: The Slave allows the Master station to 
synchronize the clock on the Slave station. 

11- Use UTC time base: Allows this Session to use UTC (Coordinated Universal Time) for 
messages sent and received. 

12- Diag Mask: Contains the diagnostics mask for the various communication layers (default 
16#00000000: no diagnostics). To configure it, double-click the field. A Select Trace 
Options window opens for selecting the traces to be activated. Click on the following 
fields to activate them, if desired: 

o Show Time Stamps: Displays the timestamps 
o Show Errors: Displays the errors 
o Trace low-level layer: Traces the low-level layers of the OSI model 
o Trace Physical layer: Traces the physical layer of the OSI model 
o Trace Link layer: Traces the link layer of the OSI model 

Then click OK. 
13- Unsolicited messages: The following fields define the event messages. 

a. Enable unsolicited messages: Activates the transfer of unsolicited messages 
from the Slave station to the Master station. The Slave station sends unsolicited 
messages without request from the Master station. The Slave sends an unsolicited 
message on startup to announce the Restart IIN bit, and whenever unsolicited 
events meet the specifications of the Class X: Unsolicited events number or 
Class X: Unsolicited events delay parameters. 

Remark: Whatever the value of this parameter, the DNP3 Master can also poll for 
events using Class 1, 2, 3 or an object group of specific events. 

b. If the parameter Enable unsolicited messages is enabled, then configure the 
following parameters: 

Unsolicited messages parameters Description 
Default event mask Specifies the event class that will be sent in unsolicited messages, 

with the following options (default: NONE): 
• NONE: Class 0 defines the static points. 
• ONE: Class 1 defines points in high-priority events. 
• TWO: Class 2 defines points in medium-priority events. 
• THREE: Class 3 defines points in low-priority events. 
• ALL: All classes 
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Unsolicited retry number The number of times that the Slave station will attempt to send 
the same unsolicited message to the Master station without 
receiving an acknowledgment. The wait time before the next 
attempt depends on the Unsolicited retry delay. 

Unsolicited retry delay Wait time (in seconds) before the Slave executes a retry after an 
unsuccessful transmission, without receiving an acknowledgment 
from the Master. 

Unsolicited offline retry delay Wait time (in seconds) after the Unsolicited retry number has 
been reached before trying again. 

Send unsolicited when online If true, sends unsolicited messages (or an empty message) as 
soon as the connection between the Slave station and the Master 
station is established, without request from the Master station (see 
*Note). If false, unsolicited messages will be sent only if there are 
any messages pending in the queue. 
Note: Once the DNP3 Master and Slave applications have been 
loaded in the RightWON, the connection is established without 
requiring that the application program be up and running first. 

Class 1: Unsolicited events number Specifies the maximum number of Class events permitted before 
generating an unsolicited message for the Class. Class 2: Unsolicited events number 

Class 3: Unsolicited events number 
Class 1: Unsolicited events delay Wait time (in seconds) after a Class event has been received, 

before sending unsolicited messages for the Class. Class 2: Unsolicited events delay 
Class 3: Unsolicited events delay 

3.8. Adding a Variable 
Add variables to the DNP3S protocol using the DNP3S communication profile: 

1- Click Profile  in the toolbar to access the Profile window. 
2- Click on the DNP3S communication profile. 

 
3- Click Insert/Set Variable… under the Insert menu in the toolbar. 

a. Select a Variable from the list and click on √. 
b. To create a Variable, type its name and click on √. It is preferable to have a 

naming convention for the Variables. For example, you could prefix DINT 
variables with di and BOOL variables with b to declare diWindDir or bBreakerSts. 
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A new window will open; select the Variable Type and location ‘Where’ (GLOBAL 
or RETAIN), then click Yes. 
Note: Declare all Variables globally so that all functions including DNP3S can 
access them as required. 

 

3.9. Configuring a Variable 
1- Click Profile  in the toolbar to access the Profile window. 
2- Click on the DNP3S communication profile. 
3- Click on the Variable. The Variable properties are presented on the right side of the 

Profile window, as follows: 

a- Type: Select the type of static data associated with the Variable. This can be a single 
or double binary input (e.g. circuit breaker status), a binary status output, a running 
counter, an analog input or output, or a character string. Each type of Variable is 
associated with a group. 
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b- PointNum: Select the address of the point (Variable) based on the Type of group. 
The point number must be unique for each Variable of the same type. 

c- EventClass: Select the event class: 
o NONE: Static Variable; no event is associated with the point. These points are 

retrieved only on request from the Master. 
o ONE, TWO, THREE: Event Variable. Select Class 1 (high priority), 2 or 3 (low 

priority) for the Variable. 
o Default: Uses the Default Class Event of the DNP3 Slave protocol. 
o Persistent: Stores the events in memory during a restart of the application or 

the device. 
d- StaticVariation: The variation to return when the Master requests variation 0 in an 

integrity data poll (for static values). 
o Default: Uses the static variation defined by the Default variation of the 

DNP3 protocol. 
o 1 to 9: The variation to return. 

e- EventVariation: The variation to return when the Master requests variation 0 in an 
integrity data poll (for event values). 

o Default: Uses the event variation defined by the Default variation of the 
DNP3 protocol. 

o 1 to 9: The variation to return. 

3.10. Configuring DNP3 commands from the Master station 
The Slave receives commands from the Master station(s) through the IEC 61131-3 PLC 
application in the RightWON. 

1. Right-click on Session and click Add Variable… 

2. In Type, select Ctl: Control (INT). 

3. In Variable, enter the name of the variable (e.g.: iCtlControl). 
Note: the variable must previously be created in global variables. If not, don’t enter a 
name. Then, create the variables in global variables and drag-drop the variable on ???. 

4. Repeat from step 1 to add all of the following variables:  
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5. To automatically write the information from the command in the slave variable, create a 
structured text (ST) language program: 

//Refer in the OEM librairy to:  
//Control Variable : Incoming Request Function Code  
//Control Variable : Returned Response 
case iCtlControl of 
   DNP3S_CONTROL_REQ_IDLE:;//Idle 
   DNP3S_CONTROL_REQ_SELECT://Select 
       iCtlControl:=DNP3S_CONTROL_RESPONSE_SUCCESS_AUTO_WRITE; 
   DNP3S_CONTROL_REQ_OPER:;//Operate 
       iCtlControl:=DNP3S_CONTROL_RESPONSE_SUCCESS_AUTO_WRITE; 
   DNP3S_CONTROL_REQ_DIRECT_OPER://Direct Operate 
       iCtlControl:=DNP3S_CONTROL_RESPONSE_SUCCESS_AUTO_WRITE; 
   DNP3S_CONTROL_REQ_DIRECT_OPER_NO_ACK://Direct Operate No Ack 
       iCtlControl:=DNP3S_CONTROL_RESPONSE_SUCCESS_AUTO_WRITE; 
   DNP3S_CONTROL_REQ_CANCEL://Cancel 
       iCtlControl:=DNP3S_CONTROL_RESPONSE_SUCCESS_AUTO_WRITE; 
    else; 
end_case; 

3.11. Configuring error report variables 
The configure error report variables: 

1. Right-click on Session and click Add Variable… 

2. In Type, select an error report: 

• Session: Online (BOOL) 

• Link: Force Rx (BOOL) 

• Link: TxPending (BOOL) 

3. In Variable, enter the name of the variable (e.g.: MasterCommSts). 
Note: the variable must previously be created in global variables. If not, don’t enter a 
name. Then, create the variables in global variables and drag-drop the variable on ???. 
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3.12. Example of DNP3 Slave static configuration 
In the DNP3 example presented in the ‘Static’ file, the DNP3 protocol is configured in static 
mode. The Master must also be configured in static mode to be able to execute an integrity data 
poll of the Slave. Here is an example of the Slave configuration: 

1- Example of configuring a static DNP3 Slave 
2- Configuring the port in serial or Ethernet mode 
3- Example of configuring a static Session 
4- Example of configuring static Variables 

3.12.1. Example of configuring a static DNP3 Slave 
The default event class (Default Class Event) must be zero (NONE) for each type of Variable. 
In this way, the variables will be declared static if the default option is selected for the event 
class of the point. 
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3.12.2. Example of configuring a static Session 
Event messages are disabled (Enable unsolicited messages is unchecked). 

 
 

3.12.3. Example of configuring static Variables 
Variables must be in event class zero (EventClass set to NONE) to be static Variables. A 
Variable can also be put in the Default class if the default event class of the DNP3 Slave is 
configured as static. Here are some configuration examples of different types of static Variables: 
binary input, binary output, analog input and analog output. The point number is unique for 
each Variable of the same type. 

Analog output Variable with point number 0: 
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Binary output Variable with point number 0: 

 
Binary input Variable with point number 0: 

 
Binary input Variable with point number 1: 

 
Analog input Variable with point number 0: 

 



Document No. RWM002010-MA-en RightWON DNP3 Protocol Manual V2.3.1 
 

 

© 2013 Vizimax, Inc.  27 
All rights reserved. www.vizimax.com 

Analog input Variable with point number 1: 

 

3.13. Example of DNP3 Slave event configuration 
In the DNP3 example presented in the ‘Event’ file, the DNP3 protocol is configured in event 
mode. Events are sent to the Master as unsolicited messages. The Master must therefore be 
configured in event mode to receive the events. Here is an example of the Slave configuration: 

1- Example of configuring an event DNP3 Slave 
2- Configuring the port in serial or Ethernet mode 
3- Example of configuring an event Session 
4- Example of configuring event and static Variables 

3.13.1. Example of configuring an event DNP3 Slave 
The default event class (Default Class Event) must be 1, 2 or 3 (ONE, TWO or THREE) for 
each type of variable to be an event variable. In this way, event variables will be declared if the 
default option is selected for the event class of the point. Event class 0 (NONE) is static. 
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3.13.2. Example of configuring an event Session 
Event messages are enabled (Enable unsolicited messages is checked). You must also 
configure the Unsolicited messages section as required by the application. 

 

3.13.3. Example of configuring event and static Variables 
Variables must be in event class zero (EventClass set to NONE) to be static Variables and in 
class 1, 2 or 3 (ONE, TWO or THREE) to be event Variables. A Variable can also be put in the 
Default class if the default event class of the DNP3 Slave is configured as an event class. Here 
are some configuration examples of different types of event Variables: binary input, binary 
output, analog input and analog output. The point number is unique for each Variable of the 
same type. 

Analog output Variable with point number 0 (static): 
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Binary output Variable with point number 0 (static): 

 
Binary input Variable with point number 0: 

 
Binary input Variable with point number 1: 

 
Analog input Variable with point number 0: 
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Analog input Variable with point number 1: 
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 Tutorial on DNP3 Master configuration 
Configuration of a DNP3 Master in the RightWON requires the following steps: 

1- Installing the license key for the DNP3 protocol 
2- Adding the DNP3 Master protocol to the RightWON configuration 
3- Configuration parameters for the DNP3 Master 
4- Inserting a communication port (Channel) on the DNP3 Master protocol 
5- Configuring the communication port 
6- Inserting a data block (Session) on the communication port 
7- Configuration parameters for a Session 
8- Adding Variables to the Session 
9- Configuring DNP3 commands to the Slave station. 
10- Configuring error report variables. 
11- Example of configuring a DNP3 Master in static or event mode 

4.1. Adding the DNP3 Master protocol to the RightWON configuration 
The DNP3 Master can be added to the RightWON configuration when a new project is created, or 
through the fieldbus manager by carrying out the following operations: 

1- Start the fieldbus configurator by clicking Fieldbus Configurations  in the toolbar. 
2- Click Insert Configuration…  in the editing area toolbar. 
3- In the new window, expand the DNP3 configuration and double-click on the DNP3 

Master protocol. 
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4.2. Configuration parameters for the DNP3 Master 
Several parameters are available for configuring the DNP3 Master. To view these parameters, 
double-click on DNP3 Master. Here is the list of available parameters: 

• Log traces: The log messages are displayed in the output window of the RightWON 
Configuration Suite. This takes time and should be reserved for troubleshooting. 

• Use VSI for flags and TimeStamp: Permits using status flags and timestamps 
according to the following options: 

o Don’t use VSI: Do not use standard variable status bits (VSI) 
o Use VSI: Use standard VSI 
o Use Std VSI and User bits (1-8): Use standard VSI and user bits (1-8) 

4.2.1. Activate status bits 
To activate status bits management: 

1. Select Project>Settings. 

2. In Compiler section, double-click on Allocate status flags for variables with 
embedded properties. 

3. Click OK. 
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4.3. Configuration parameters for a Master Session 

After inserting a session, you can configure it using the Fieldbus Configurations . 

Note: The Master should have one session for each Slave that the Master station controls. Each 
session of the DNP3 Master protocol must be configured to process the information of the Slave 
station. Thus the DNP3 protocol is configured in the same way as for the Slave, in static or 
event mode. 

 
Click Session in the IO Drivers window. To set a parameter, double-click it. Enter the data in 
the field and press Enter on the keyboard. To enable (checked box) or disable a parameter, 
click on the box. Here is the list of parameters to configure: 

1- Session ID: Enter a unique identification number for the session. 
2- Session Name: Enter the name of the session. 
3- Master Address: Enter the address of the Master station. 
4- Outstation Address: Enter the address of the Slave station. 

Note: For broadcast messaging, create a session and enter 65535 in the Outstation 
Address field. A broadcast permits data transmission only to all Slave stations. The 
DNP3 status is not returned from the Slave stations. 
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5- Keep Alive: Enter the time (in milliseconds) between signals that verify the status of the 

connection between the Master and Slave (Link Confirm Time Out on the Channel). 
6- Integrity Interval: Delay (in seconds) before polling the static points. 
7- Event Interval: Delay before polling the events and for receiving an acknowledgment. 
8- Enable unsolicited class 1: Enables unsolicited Class 1 messages. 
9- Enable unsolicited class 2: Enables unsolicited Class 2 messages. 

10- Enable unsolicited class 3: Enables unsolicited Class 3 messages. 

11- Use UTC time base: Allows this Session to use UTC (Coordinated Universal Time). 

12- Command Time Out: The time allotted for executing a request generated by the 
Session before declaring a failure. 

13- Automatic Behavior: The mask used to enable/disable automatic processing of 
requests. To configure it, double-click the field. The Select Automatic Behavior 
window opens. Click on the following fields to activate them, if desired: 

Automatic Behavior parameters Description 
Clear IIN restart bit Resets the IIN restart bit to 0. (INN: “Internal Information”) 
Issue integrity data poll on restart Issues a data poll after a restart. 
Issue integrity data poll after local 
IIN bit was set and cleared 

Issues a data poll after the local IIN bit has been set to 1 and 
then reset to 0. 

Issue integrity data poll on timeout Issues a data poll when a timeout expires. 
Issue integrity data poll on buffer 
overflow 

Issues a data poll when a buffer overflows. 

Use delay measurement in time sync When synchronizing the time, uses a measurement of the time it 
takes for a request to travel from the Master to the Slave. 

Perform time sync on need time 
using serial method 

Performs time synchronization on request from the Slave, using a 
serial transmission method. 

Issue event data poll when class 1,2, 
or 3 IIN bit is set 

Issues a data poll when the IIN bit in Class 1, 2 or 3 is set to 1. 

Automatically enable unsolicited 
events upon remote or master device 
startup 

Enables unsolicited events automatically on startup of the Slave 
or Master station. Unsolicited responses must also be permitted 
on the Slave station. 

Automatically disable unsolicited 
events upon remote device startup, 
Not necessary, outstation should be 
disable at start-up 

Automatically disables unsolicited events during startup of the 
Slave station. This parameter is not required, since the Slave 
station should already be disabled on startup. 
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Note: Whatever the value of this parameter, the Session can also 
poll events using Class 1, 2, 3 or an object group of specific 
events. 

Enable/Disable automatic generation 
of application layer confirmations 

Enables/Disables automatic generation of confirmations from the 
application layer 

Perform time sync on need time 
using LAN method 

Performs time synchronization on request from the Slave, using a 
LAN transmission method. 

Exchange data set prototypes and 
descriptors with slave when IIN 
restart bit is set or when master 
restarts 

Exchanges the data set prototypes with the Slave when the IIN 
restart bit is set to 1 or on restart of the Master. 

Issue integrity data poll when session 
becomes ‘online’, meaning connected 

Issues a data poll when the session is ‘online’, that is, connected. 

Master unsolicited Startup Executes an unsolicited startup sequence on the Master. 
Request Obj 50 with integrity poll to 
Time Stamp values 

Adds the timestamp to a data poll of static objects. 

 

14- Diag Mask: Contains the diagnostics mask for the various communication layers (default 
16#00000000: no diagnostics). To configure it, double-click the field. A Select Trace 
Options window opens. Click on the following fields to activate them, if desired: 

o Show Time Stamps: Displays the timestamps 
o Show Errors: Displays the errors 
o Trace Transport layer: Traces the transport layer of the OSI model 
o Trace Application layer: Traces the application layer of the OSI model 
o Trace User level layer: Traces the user-level layer (traces Requests and 

Responses) 
o Display Static Data Header: Displays the headers for static data. 
o Display Static Data Values: Displays the values of the static data. 
o Display Event Data Header: Displays the headers for event data. 
o Display Event Data Values: Displays the values of the event data. 

4.4. Adding and configuring an input Variable 
Add variables to the Session by executing the following steps: 

1- Using the Fieldbus Configurations , click Session in the expanded tree under DNP3 
Master in the IO Drivers window. 

2- Click Insert/Set Variable… under the Insert menu, or click the  icon in the toolbar. 
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3- A new window will open. For the Symbol field, click on  and either: 

 
a. Select a Variable from the list and click on √. (e.g. bOpenCloseValve) 
b. Create a Variable by typing its name and clicking on √. It is preferable to have a 

naming convention for the Variables. For example, you could prefix DINT 
variables with di and BOOL variables with b to declare diWindDir. 

 
A new window will open; select the Variable Type and location ‘Where’ (GLOBAL 
or RETAIN), then click Yes. 
Note: Declare all Variables globally so that all functions including DNP3S can 
access them as required. 

 
4- Select the type of Operation: Data Exchange (Read data) or Error Log. 
5- Enter the Type and the Point Number. 
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Note: You must enter the same Type and Point Number that are defined in the Slave 
station for the point. The Master uses these two pieces of information to exchange data 
with the Slave concerning this point. 

6- Click OK. 

 

4.5. Configuring DNP3 commands to the Slave station 
The Master sends commands to the Slave station(s) through the IEC 61131-3 PLC application in 
the RightWON. The following commands are examples that show how commands can be used to 
allow the Master to exchange data with the Slave. For more information on DNP3 commands, 
see DNP3 Master function blocks in the RightWON Configuration Suite Help by pressing the 
F1 key. 

Example of a binary output command: 

In a function block diagram (FBD) program, declare the following program. 

 
Execution of a binary output command, written in structured (ST) language program: 
//The following command example allows controlling the variable bBreakerSts in the Slave. 
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//Refers to DNP3 Library defines (OEM) to get more info. 
    if ( SendCmdBin_Ready ) then 
       SendCmdBin_Session:=0;    //Session number 
       if bToggleValue then 
           SendCmdBin_Ctrl:=DNP3M_CROB_CTRL_LATCH_ON; //Refer to Binary Controls in OEM Library 
       else 
           SendCmdBin_Ctrl:=DNP3M_CROB_CTRL_LATCH_OFF; //Refer to Binary Controls in OEM Library 
       end_if; 
       SendCmdBin_Point:=0;  //Point Number of the variable 
       SendCmdBin_FC:=DNP3M_FC_DIRECT_OP_NOACK; //Refer to Master Function Codes in OEM Library 
       SendCmdBin_Qual:=DNP3M_QUAL_16BIT_INDEX;  
    //Refer to Analog/Binary Control Qualifiers in OEM Library 
       SendCmdTON_Val:=t#1s;//On duration 
       SendCmdTOFF_Val:=t#1s;//Off duration 
       bSendCmdBin:=true; //Activate the trigger to send the command 
     
        //To verify if the command was successful. Refer to Response values in OEM Library 
        if(SendCmdBin_RC = DNP3M_RESP_STATUS_SUCCESS ) then 
            bBinCmdSts:=true; 
            bToggleValue:= NOT(bToggleValue); 
        else 
            bBinCmdSts:=false;  
        end_if; 
    end_if; 

 

Example of an analog output command 
In a (FBD) function block diagram program, declare the following program. 
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Execution of an analog output command, written in structured (ST) language: 

//The following command example allows controlling the variable rPressueValve in the Slave. 

//Refers to DNP3 Library defines (OEM) to get more info. Refer to Response values in OEM Library. 
if SendCmdAnlg_Ready then 
   SendCmdAnlg_Session:=0;  //Session number 
   SendCmdAnlg_Point:=0; //Point Number 
   SendCmdAnlg_FC:=DNP3M_FC_DIRECT_OP_NOACK; //Refer to Master Function Codes in OEM Library 
   SendCmdAnlg_Vart:= DNP3M_AN_OUT_VARIATION_32BIT_REAL; 
   //Refer to Master Function Codes in OEM Library 
   SendCmdAnlg_Qual:= DNP3M_QUAL_16BIT_INDEX;  
   //Refer to Analog Controls Variations in OEM Library 
   SendCmdAnlg_Val:=r_AnaValue; //Analog value to be sent to the Slave station. 
   bSendCmdAnlg:=true; //Activate the trigger to send the command 
 
//Return the analog output status   
    if SendCmdAnlg_RC = DNP3M_RESP_STATUS_SUCCESS then 
        bCmdSts:=true; 
    else 
        bCmdSts:=false; 
    end_if; 
end_if; 
 

Example of an integrity poll command: 
This command is used for retrieving static values from the Slave station(s) instead of using the 
Integrity Interval parameter in the master session. 

 
 

Execution of an integrity poll command, written in structured language: 

SendCmdIntegPoll_Session:=0; //Session number 
if SendIntegPoll_Ready then  
 bSendIntegPoll:=true; 
else 
 return; 
end_if; 
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Example of an event poll command: 

This command is used for retrieving events values from the Slave station(s) instead of using the 
Event Interval parameter in the master session. 

 

 

Execution of an event poll command, written in structured language: 

SendCmdEventPoll_Session:=0;  //Session number 
if SendEventPoll_Ready then 
 bSendEventPoll:=true; 
else 
 return; 
end_if; 

4.6. Configuring error report variables 
The configure error report variables: 

1. Right-click on Session and click Add Variable… 

2. In Operation, select Error Report 

3. In Symbol, enter the name of the variable (e.g.: SlaveCommSts). 
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4.7. Example of multiple DNP3 Sessions in the Master station 
In the Master station, a port (Channel) can carry more than one session. This allows the Master 
station to exchange with more than one Slave station. You can configure multiple sessions 
(Session) on one port in Ethernet mode and other sessions on the other port in serial mode. 

In the example below, each Session on the Master communicates with a different Slave station 
over the same serial communication port. 

 

4.8. Example of configuring a DNP3 Master in static or event mode 
The DNP3 Master protocol can be configured in static or event mode. Here is how the examples 
are configured: 

1- Example of configuring a DNP3 Master 
2- Configuring the port in serial or Ethernet mode 
3- Example of configuring a Session in either: 

• Static mode 
• Event mode 

4- Example of configuring the Variables 

4.8.1. Example of configuring a DNP3 Master 
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4.8.2. Example of configuring a static Session 

 
The following configuration options are available in the Automatic Behavior window for 
automatic processing of requests: 
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4.8.3. Example of configuring an event Session 

 
The following configuration options are available in the Automatic Behavior window for 
automatic processing of requests: 

 

4.8.4. Example of configuring Variables in a Master Session 
Here are some configuration examples for Variables of Type binary input and analog input. The 
Point Number is unique for each Variable of the same type. The bBreakerSts and 
rPressureValve Variables are not added to the Master session, since it is the Master that 
modifies these variables by sending commands to the Slave. 

Note: The Variable Type and Point Number must be identical on the Slave. 
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Binary input Variable with point number 0: 

 

Binary input Variable with point number 1: 

 

Analog input Variable with point number 0: 

 

Analog input Variable with point number 1: 
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 Example of the data exchange between Master and 
Slave 

The Master and Slave communicate with each other via a serial communication port. They 
exchange data in either static or event mode. In event mode, the Slave station periodically 
sends events to the Master station without prior request from the Master. In static mode, the 
Master station periodically sends a poll to retrieve the data from the Slave station. 

5.1. Example of Master and Slave operations in event mode 
Operations at the Slave station: When the wind speed (rWindSpd) and wind direction 
(diWindDir) variables change in the Slave station, it generates an event that will be sent to the 
Master station. These events are sent according to the parameters of the Class they are defined 
in (Class 1, 2 or 3). Class 1 has the highest priority, and Class 3 the lowest. 

 
 

Pressure valve opening: To open the valve at the Slave station, click bOpenCloseValve and 
change its status from False  True. An event is then sent to the Master station. 
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Circuit breaker opening: To open the circuit breaker at the Slave station, click bOpenBreaker 
and change its state from False  True. The status is then transferred to the Master station as 
an event. 

 
 

Operations at the Master station: The Master receives the events from the Slave station, 
which notify it of the new Variable values. The data of the rWindSpd, diWindDir, bOpenBreaker 
and bOpenCloseValve Variables are then written to the corresponding Variables in the Master. 

 
 

Pressure valve opening: In the program of the master, change the value of the analog point 
‘rPressureValve’ to 70.0. Then, the Master station sends an analog command to the Slave 
station. 

Circuit breaker opening: In the program of the master, change the state of the binary point 
‘bBreakerSts’ from False  True. A binary command is sent to the Slave station. 
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5.2. Example of Master and Slave operations in static mode 
Operations at the Slave station: The Variables for wind speed (rWindSpd) and wind direction 
(diWindDir) change periodically in the Slave station. In the static mode example, the Slave does 
not send the events. 

Pressure valve opening: To open the valve at the Slave station, click bOpenCloseValve to 
change its status from False  True. 

Circuit breaker opening: To open the circuit breaker at the Slave station, click bOpenBreaker to 
change its state from False  True. 

Operations at the Master station: The Master station periodically polls the points (rWindSpd, 
diWindDir, bOpenBreaker and bOpenCloseValve) at the Slave station. The Master retrieves the 
values of the Slave station points in this way. The data of these points are then stored in the 
corresponding Variables in the Master. The Master executes the following commands: 

Pressure valve opening: In the program of the master, change the value of the analog point 
‘rPressureValve’ to 70.0. Then, the Master station sends an analog command to the Slave 
station. 

Circuit breaker opening: In the program of the master, change the state of the binary point 
‘bBreakerSts’ from False  True. A binary command is sent to the Slave station. 
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 Configuring a project in Master/Slave mode 
This mode allows a RightWON to exchange data with one or more Slave stations and, in 
addition, to exchange the data with a Master. 

To configure the RightWON in Master/Slave mode, simply carry out the following steps in the 
same RightWON: 

Note: The license key needs to be installed only once for a DNP3 Master/Slave project. 

1- Add and configure the DNP3 Slave in the RightWON configuration 

2- Add and configure the DNP3 Master in the RightWON configuration 
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